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1. CITATIONS

CITATIONS SHOULD ALWAYS BE COMPLETE AND SET OUT IN THE
FOLLOWING FORMAT:

1.1 BOOKS

e Cite author surname and title of book in a text where footnotes are used.

Example
Beaumont and McEleavy, Anton’s Private International Law.

o Full citation should be included in the footnote and should consist of the following elements:
Authors (forename or initials, followed by surname);

Title (in italics, including statement of original authorship where it is an integral part of the title);
Editor/subsidiary author (forename or initials followed by surname);

Edition (where not the first);

Place of publication, publisher and year of publication (in brackets);

Volume number (where available); and

Page reference where citation is not to the whole item.

® 6 6 ¢ ¢ 0 o

Examples

F. Davidson, H.R. Dundas and D. Bartos, Arbitration (Scotland) Act 2010
(Edinburgh: W. Green, 2010), pp.12-13.

S. Pollock and T. Maitland, The History of English Law, 2nd edn (Arnhem:
Kluwer, 1911), Vol.1, pp.518, 520-522.

Chitty on Contracts, edited by H.G. Beale, 28th edn (London: Sweet &
Maxwell, 1999), Vol.1, paras 4-024—4-029.

G. Black (ed.), Woolman on Contract, 4th edn (Edinburgh: W. Green, 2010),
p.120.

¢ Include the full citation in the text if footnotes are not used.

e For subsequent references, cite author surname, title of book, year of publication (in brackets) and
page/paragraph number.

Examples
Davidson, Dundas and Bartos, Arbitration (Scotland) Act 2010 (2010), pp.12-13.
Pollock and Maitland, The History of English Law (1911), pp.520-522.

2|Page




1.2 ESSAYS IN COLLECTION

o Cite author surname and title of essay in text where footnotes are used. The title should be in roman
text with double quotation marks.

Example
Maitland, “The Mystery of Seisin”.

o Full citation should be included in the footnote and should consist of the following elements:
Author of essay

Title of essay in double quotation marks

Title of book (in italics)

Place of publication, publisher and year of publication (in brackets)

Volume number (where available)

Page reference

* 6 6 ¢ 0 o

Examples
T. Maitland, “The Mystery of Seisin” in Select Essays on Anglo-American Legal
History (London: Sweet & Maxwell, 1993), Vol.3, p.591.
R. Goldberg, “Concepts of Depreciation” in lan Baxter and John Davidson (eds),
Studies in Accounting Theory, 2nd edn (London: Sweet & Maxwell, 1998), p.236.

e Include full citation in text if footnotes are not used.

e For subsequent references, cite author surname, title of essay, title of book, year of publication (in
brackets) and page/paragraph number.

Example
Maitland, “The Mystery of Seisin” in Select Essays on Anglo-American Legal
History (1993), p.591.

1.3 LEGAL PERIODICALS

e Cite author surname and title of article in text where footnotes are used. The title should be in
roman text with double quotation marks.

Example
Getzler, “Forfeiture for breach of a time condition”.
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o Full citation should be included in the footnote and should consist of the following elements:
+ Author (forename or initials, followed by surname);
+ Title of article in double quotation marks; and
+ Journal citation.

Examples
Joshua Getzler, “Forfeiture for breach of a time condition” (2004) 120 L.Q.R. 203.
W. Pengilley, “Restraint of Trade and Antitrust: A Pigskin Review Post Super
League” (1997) 6 Canterbury L. Rev. 610.

e Include full citation in the text where footnotes are not used.
o For subsequent references, cite author surname, title of article and journal citation.

Example
Getzler, “Forfeiture for breach of a time condition” (2004) 120 L.Q.R. 203.

o Use the format 203, 205 if referring to a particular page.

Example
Getzler, “Forfeiture for breach of a time condition” (2004) 120 L.Q.R. 203, 205.

1.4 GOVERNMENT PUBLICATIONS

e Cite author and title in text where footnotes are used.

Examples
Law Reform Committee, First report of the Law Reform Committee.
House of Commons, Select Committee on Modernisation of the House of Commons,
Scrutiny of European matters in the House of Commons.

o Full citation should be included in the footnote and should consist of the following elements:

*

* & ¢ o

Official body;

Title (in italics);
Section/department responsible;
Date of publication; and

Series.
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Examples
Law Reform Committee, First report of the Law Reform Committee (HMSO, 1963),
Cmnd.641.
Government memorandum from the Leader of the House of Commons: session
2003-04 (The Stationery Office, 2004), HC Paper N0.508 (Session 2003/04).

e Include full citation in the text where footnotes are not used.
o For subsequent references, cite author and title.

1.5 E-TERMINOLOGY

o Use italics for website addresses (not underlined or bold).
o Include http:// at the start of website addresses.

e Add an accessed date in the form “[Accessed January 17, 2011]” as pages can go out of date very
quickly.

Example
http://www.official-documents.gov.uk/document/cm68/6878/6878.asp [Accessed July
1, 2008].

1.6 CASES

o Cite shortened case name, refer to one party only, or use nickname in text where footnotes are used

Example
As was proposed by the Master of the Rolls in Filmlab and confirmed by the
House of Lords in Hurst.

o Full citation should be included in the footnote and should consist of the following elements:
+ Party names (in italics, separated by a v without a full point);
+ Media neutral citation (first in string of citations) and law report reference(s) where available; and
+ Unreported, date and court where no citations are available (do not include commas between these
elements).

Examples
Barnet LBC v Hurst [2002] EWCA Civ 1009; [2003] 1 W.L.R. 722.
HM Advocate v Purves, 2009 S.L.T. 969.
Dean v Woods Unreported April 21, 1994 CA (Civ Div).
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Include full citation in the text if footnotes are not used.

o For subsequent references, use shortened case name, refer to one party only, or use a nickname and
include at least one published report series.

e Use “at” when referring to pages of law reports. Do not use “p.” for page. Where subsequent
references to pages are made, separate by a comma.

e Paragraph numbers should appear in square brackets.

Examples
Rye v Rye [1994] A.C. 496 HL at 500.
Rye v Rye [1994] A.C. 496 HL at 500, 503-505.
R. (on the application of Crouch) v DPP [2009] P.N.L.R. 1 QBD at [1], [3] and [5]-

[6].

1.7 LEGISLATION
1.7.1 Statutes

o Include full title in main text on first citation, with section number either following or preceding the
name of the Act with no comma after the year.

Example
Family Law (Scotland) Act 2006 s.3.
s.3 of the Family Law (Scotland) Act 2006.

o Do not use acronyms for legislation in the main text unless the legislation is frequently referred to in
the product. Usage must be consistent within the product with legislation in full on first mention,
followed by the acronym in brackets. Provide an abbreviations list.

Example
Income and Corporation Taxes Act 1988 (“ICTA”).

o For subsequent references in the main text, use the year of the Act. If only one Act is mentioned, the
year can be dropped.

Example
the 1925 Act
the Act
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¢ Include the full title in footnotes on first citation, with section number following the name of the Act
with no comma after the year. Include the acronym or abbreviated title in brackets.

Example
Law of Property Act 1925 (LPA 1925) s.3.

e For subsequent references in footnotes use the acronym or abbreviated title.

1.7.2 Statutory Instruments

o Include the full title in the main text on first citation (name, year and number), with
regulation/rule/article number following the name of the SI with no comma after SI number.

Examples
Act of Sederunt (Rules of the Court Session 1994) (SI 1994/1443) Sch.2 para.l.1.
Automated Registration of Title to Land (Electronic Communications) (Scotland)
Order 2006 (SSI 2006/491) art.4.

o Do not use acronyms for legislation in the main text unless the legislation is frequently referred to in
the product. Usage must be consistent within the product with legislation in full on first mention,
followed by the acronym in brackets. Provide an abbreviations list.

Example
Act of Sederunt (Rules of the Court Session 1994) (SI 1994/1443) (“RCS”) Sch.2
para.l.l1.

o For subsequent references in the main text, use the year of the Sl. If only one Sl is mentioned, the
year can be dropped.

Examples
1994 Rules
2006 Order

¢ Include the full title in footnotes on first citation, with regulation/rule/article number following the
name of the SI, with no comma after the number. Include the acronym or abbreviated title in
brackets.

Example
Automated Registration of Title to Land (Electronic Communications) (Scotland)
Order 2006 (SSI 2006/491) (2006 Order) art.4.

o For subsequent references in footnotes use the acronym or abbreviated title.
7|Page



2. PARAGRAPH NUMBERING

PARAGRAPH NUMBERS SHOULD ALWAYS BE COMPLETED BY THE
AUTHOR BEFORE SUBMITTING FINAL MATERIAL.

e Paragraph numbers should be added before submission of your completed material to your
Publisher, rather than at proof stage. They provide structure to the text and are also used for
referencing in the tables and index.

e Numbers should be attached to paragraphs rather than headings and need to follow a specific style
(1-01, 1-02, etc).

Example

Introduction
1-01 The aim of this book is to provide an introduction to company law and to
deal, in particular, with the formation ...

e There should be a paragraph number against every first paragraph under a heading, and thereafter
aim to include at least one paragraph number per page.
o If you are working on a subsequent edition, please re-paragraph where necessary.
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3. HEADINGS

A CONSISTENT SYSTEM OF HEADINGS IS REQUIRED TO ALLOW
SUBJECT MATTER TO BE PRESENTED CLEARLY.

e The layout of headings need to be consistent and follow this hierarchy in order to ensure there is a
clear structure to the text. The indexer will also refer to the hierarchy of headings when structuring
the index to your publication.

e Please avoid numbered headings.

Example
CHAPTER 1
CHAPTER HEADING
SECTION HEADING (IF REQUIRED)

Heading 1
Text Text Text Text Text Text

Heading 2
Text Text Text Text Text Text

Heading 3: Text Text Text Text Text

Heading 4: Text Text Text Text Text
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4. MULTIPLE AUTHORS

AUTHORS SHOULD LIAISE TO ENSURE A LEVEL OF CONSISTENCY
THROUGHOUT THE PUBLICATION.

e When completing your text for submission please liaise with your co-authors or general editor to
ensure as much consistency as possible in terms of:
¢ Structuring the text in a consistent manner;

Applying paragraph numbering in a consistent manner;

Applying headings hierarchy in a consistent manner;

Inserting correct cross-references if required; and

Strategy for corrections.

* & ¢ o
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5. CORRECTION AT PROOF STAGE

CHANGES AT PROOF STAGE SHOULD ONLY INCLUDE ESSENTIAL
CORRECTIONS.

e You will be sent a typeset version of your publication at the 1st proof stage. The in-house Editor
managing your title will advise you when you will receive it and can send either hard copy or a PDF.

e Changes at this stage should be kept to a minimum as far as possible, incorporating corrections
which are essential to ensure the accuracy of the text.

o Checks which should be carried out include:

General check of content;

Ensure all author queries sent to you by the editor are resolved;

Check that the hierarchy of all headings is correct;

Check that all paragraph cross references have been filled in, including in footnotes; and
Check that all tabular material is set correctly.

YVVVYY

e The in-house Editor will incorporate your corrections to a master copy, advising you if any changes
could not be included, and will make thorough checks at 2nd proof stage to ensure that the
typesetter has completed these changes accurately.

o Please keep a photocopy of all corrections to prevent problems arising if copy goes missing in the
post, etc.
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6. FOOTNOTES

FOOTNOTES SHOULD BE INSERTED USING THE AUTOMATED
TOOL IN WORD, RATHER THAN INSERTING THEM MANUALLY.!

o Numbered footnotes should be used, starting from 1 at the beginning of every chapter, and should
appear at the foot of the page they refer to.

o Footnotes should appear after full points and commas but before colons and semi colons.

¢ Where footnotes are used, references in the text can be brief. However, the full reference should
appear in the footnotes (see the “Citation” section for detailed guidance).

Example
The decision in Bateman," upholding the decision ...

! Bateman v Asda Stores Ltd [2010] I.R.L.R. 370.

o Where footnotes are not used, the full reference should be given in the text.

Example

The decision in Bateman v Asda Stores Ltd [2010] I.R.L.R. 370, upholding the
decision ...

o Legislation citations that appear in footnotes must appear in full to avoid confusion.

Example
Family Law (Scotland) Act 2006 s.28.

not simply “s.28”.

e Renumbering at proof stage should be avoided if at all possible. It is time consuming and expensive
to renumber.

o Please avoid terms such as op. cit. and Ibid as they require the user to refer back to previous
citations. Simply cite in an abbreviated format (see the “Citation” section).

! Please refer to the Appendix for the “How To Guide”.
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7. CROSS REFERENCES

IT IS THE AUTHOR’S RESPONSIBILITY TO COMPLETE CROSS
REFERENCES.

e Cross references should be to paragraph number or footnote and should be completed before
submission and checked at proof stage.

Example
See para.1-31.
See paras 2-01—2-10.
See fn.2.
See fnn.4-6.

e A book should always be adequately cross-referenced, but over-cross-referencing to page number
should be avoided if possible, as these will have to be filled in at page proof stage.
o Do not use “supra/ante” or “infra/post”. If necessary, replace with “above” or “below”.
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8. GRAPHICS AND TABLES

GRAPHICS AND/OR TABLES MUST BE SUBMITTED WITH THE
COPY IF POSSIBLE AND SHOULD NOT BE INSERTED AT PROOF
STAGE.

e Submit electronically if feasible or, if this is a problem, let us know as soon as possible so we can
resolve this in-house.
e The author must let us know if permissions are required.
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9. APPENDICES

ALL APPENDIX INFORMATION MUST BE INCLUDED AT THE SAME
TIME THAT THE MAIN TEXT IS SUBMITTED.

¢ Appendix information includes legislation, forms, styles/precedents, tables, diagrams, etc.

o All appendix information must be submitted to the publisher with the manuscript. Should you need
the editorial department to source any appendix information please be as specific as possible
regarding what requires to be included in order to avoid correction, deletion or replacement of
material at proof stage.

o Where styles/precedents are included please note that these will be anonomised in house to ensure
that they are easy to use for the subscriber.

Example
LEASE OF SUBJECTS

[address]
[date]
Dear [name]
On behalf of and as instructed by our client [name] (hereinafter called “the
proprietor”), we hereby offer to lease to you, [name], (hereinafter together called

“the tenant”), the property known as [address] (hereinafter called “the property”)
on the following terms and conditions...
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10. QUOTATIONS

THE CONTENT OF QUOTATIONS WILL NOT BE CHECKED IN-HOUSE
BUT THE QUOTATION WILL BE FORMATTED ACCORDING TO
HOUSE STYLE.

e The content of the quotation will not be checked in house unless there is an obvious error, in which
case it will be brought to your attention by the editor.

o A full citation is required, including page reference. If you are quoting from an opinion/transcript
include a paragraph number where appropriate.

e Only direct quotations should be in quotation marks. Do not insert quotation marks if you are
paraphrasing.

e A quote within a quote should appear in single quotation marks.

¢ Interpolations or corrections, including grammatical or spelling errors, should either be replaced by
the correct word or phrase in square brackets or should be allowed to stand followed by “[sic]”.

o House style will be applied by the editor to the layout of quotations. Style points to note are:

¢ Short quotations (less than 22 words) will be within the text and will start with a lower case letter.
Longer quotations will start as a new and indented paragraph.
+ If the quotation is a new sentence or paragraph it will be preceded by a colon.

Example

The claimant’s solicitors said:

“In all the circumstances, we do not consider that a telephone hearing would
give our client an adequate opportunity to put his case to you.”

+ |f the quotation is not a new sentence or paragraph and runs on from the previous text, punctuation and
initial capitals will not be included.

Example

During the House of Lords second reading, on June 7, 2011, Baroness Hanham
observed that

“the Bill provides for compulsory referendums on the council tax levy where it
is deemed excessive by the Secretary of State...”

+ If punctuation is part of a quotation it will appear inside the quotation marks

Example

“The goodwill of a business is one whole. Goodwill has no independent
existence. It cannot subsist by itself. It must be attached to a business.”
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+ If punctuation has been added but is not part of the quotation, it will appear outside the quotation marks

Example

As Collins C.J. observed, “the goodwill formed part of the business”.
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APPENDIX
A.1 HOUSE STYLE

1.1 ABBREVIATIONS
¢ Use the following commonly occurring contractions and abbreviations (except at the beginning of a
sentence).
App. Application
Apps Applications
art. article (UK, foreign domestic, international and EU legislation)
Art. Article (European Patent legislation only)
arts articles (UK, foreign domestic, international and EU legislation)
Arts Articles (European Patent legislation only)
asp Act of the Scottish Parliament
C. chapter (when referring to the chapter number of an Act)
Ch. Chapter (when referring to book chapters)
Chs Chapters (when referring to book chapters)
Ch. Chapter of an Act or Sl
Chs Chapters of an Act or SI
cl. clause
cll. clauses
col. column
cols columns
Co Company
Corp Corporation
Dir. Direction
Dr Doctor
ed. editor
eds editors
edn edition
fig. figure
figs figures
fn. footnote/note (not n.)
fon. footnotes/notes
In. line
Inn. lines
Ltd Limited (not LTD or Itd)
Messrs Plural of Mister
No. number
Nos numbers
p. page
pp. pages
para. paragraph
paras paragraphs
Plc Public Limited Company (not PLC or plc)
Pt Part
Pts Parts
r. rule
. rules (except when referring to the title of an entire piece of legislation)
reg. regulation
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regs

S.

SS.

Sch.

Schs

Sch.nn para.nn
Sch.nn Pt nn
SI

SSi

subs.

subss.

Vol.

Vols

regulations (except when referring to the title of an entire piece of legislation)

section

sections

Schedule (not Sched.)
Schedules (not Scheds)

Schedule paragraph—sublevels of Acts and Sls

As above Schedule Part
Statutory Instrument

Scottish Statutory Instrument

subsection
subsections
Volume
Volumes

1.2 FOREIGN WORDS AND PHRASES

o ltalicise all foreign words and phrases unless they have naturalised into English.
e The following are regarded as having passed into everyday legal usage. Any foreign words or
phrases not listed here should be italicised.

a fortiori

ab initio

ad hoc

ante

bona vacantia
cestui que trust
curator ad litem
de facto

de novo

e.g.

et al

ex parte

ex officio

ferae naturae
forum non conveniens
ibid.

in personam
indicia

inter alia

inter vivos
lacuna

locus standi
mens rea

nisi

non sequitur
obiter dictum, dicta
per

per caput

post

pro bono

pro tanto
quaere, sed quaere
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a prendre

acte clair

ad valorem
autrefois acquit
caveat/caveat emptor
cf.

curator bonis
de jure

dictum, dicta
ejusdem generis
et seq.

ex post facto

ex tempore
fieri facias
functus officio
i.e.

in loco parentis
insitu

inter alios

intra vires
laissez-faire
mala fides
modus operandi
nisi prius
novus actus interveniens
pari passu

per annum

per curiam

post mortem
pro forma
profit a prendre
quantum

a priori

actus reus
amicus curiae
bona fide
certiorari

chose in action
cy-pres

de minimis (non curat lex)
doli incapax

etc

ex gratia

ex relatione

ex turpi causa (non oritur action)
force majeure
habeas corpus

in camera

inrem

infra

inter partes

ipso facto

locus in quo
mandamus
mutatis mutandis
non compos mentis
obiter

passim

per capita

per se

prima facie

pro rata

qua

guantum meruit




quasi quia timet
quorum raison d’étre
res gestae res ipsa loquitur
restitutio in integrum semble
simpliciter sine die

stare decisis status quo (ante)
sub nom. subpoena

sui juris supra
uberrimae fidei ultra vires

via vice versa

viz voir dire

quid pro quo
ratio decidendi
res judicata
seriatim

sine qua non
sub judice

sui generis
terra nullius
verbatim
Vis-a-vis
volenti non fit injuria

1.3 GENDER NEUTRAL

e Aim to use gender neutral nouns, rephrasing where necessary to the plural or passive.

Examples
(Plural)

instead of

(Passive)

instead of

Customers would like to see their cases published in Current Law ...

The customer would like to see his cases published in Current Law ...

The sum was to be disclosed to the judge after judgment had been given ...

The sum was to be disclosed to the judge after he had given judgment ...

o If rephrasing to the plural or passive is not possible, use either “he” or “she” but ensure consistency

and do not alternate within a single piece of text.

1.4 CAPITALISATION

The use of capital letters must be consistent.

Lots of capital letters are distracting; when in doubt, use lower case.
Use initial capitals for proper nouns including names of people, places, days, months, buildings, etc.
Use initial capitals where a specific court is named or where a reference to a court can only possibly

mean one particular court. Use lower case initials when the reference to court is general or non-

specific.

Examples
The case at the High Court in Edinburgh...
It would be for the court to decide...
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e Use initial capitals where a specific reference is made to a judge or recorder. Use lower case initials
where making a general reference to a judge.

Examples
a Judge in Lunacy
H.H. Judge Brown
Recorder Smith
...a judge in chambers
...the judge expressed the view that...

1.5 LISTS

e Use bullet points for lists and for sub-levels within bulleted lists use em-dashes (ctrl-alt-minus sign
on number keypad).

Example
e (Case citations
— party names
— case references

o Use numbered lists if specifically required and for sub-levels within numbered lists use the following
pattern:

Example
(1) Case citations
(a) party names
(b) case references
(i) court
(i) judge
(2) Legislation citations
(a) act name
(b) year

o List items which are complete sentences start with initial upper case and end in full points.
If the sentence preceding the list ends in a full stop, then each list item should be initial upper case

and end with a full point.
¢ If the sentence preceding the list ends in a colon then each list item should begin with lower case and

end in a semi-colon, with the last bullet point ending in a full stop.
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A.2 EDITORIAL AND
PRODUCTION PROCESS

2.1 THE HANDOVER MEETING

Once the commissioning editor is satisfied that the manuscript is ready for the production phase, a handover
meeting will be arranged. The manuscript will be passed to one of our legal editors in the editorial department
who will manage the title through the production process. The member of the marketing department
responsible for the book will also be present. The purpose of this meeting is to ensure that all of those
involved with the book have had a chance to talk to the commissioning department and ensure that all relevant
information is passed on. From this point on your primary point of contact will be your legal editor.

2.2 THE EDITORIAL DEPARTMENT

Our editorial department is highly experienced and our legal editors are trained to deal with the particular
needs of legal texts. All our editors have either legal or publishing qualifications, and our training programme
is tailored to ensure they have the necessary mix of skills to produce publications of the highest possible
standard. The editor responsible for your book will project manage the production process and co-ordinate
freelance copyeditors, indexers, tablers and typesetting.

Shortly after the handover meeting, your editor will get in contact with a schedule for publication. Your
editor will also send you an index questionnaire to check whether there are specific topics you wish to see
highlighted in the index. The most important dates for an author in the publication schedule are the dates when
you will receive the proofs and the date we would like them to be returned. Please let your editor know if you
will not be available to check proofs in line with this schedule, as we pre-book typesetting and printing slots to
prevent delay.

2.3 MANUSCRIPT COPY EDIT

The freelance copyeditor (or legal editor) will carry out the following:

Detailed edit for sense—is meaning clear, with no gaps, contradictions or ambiguities?
Organisation and structure.

Grammar, spelling and punctuation.

Imposing “house style” for consistency.

Typographical specification/design.

Preparing preliminary pages.

Organising preparation of tables and indices.

YVVVVYVYVYY

2.4 FIRST PROOFS

Once the copy edit is complete, the manuscript will be typeset and you will receive the first proofs. This will
include a list of any queries which may have arisen during the copy edit. When you receive the proofs we ask
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that you read through the text to ensure their accuracy and mark any corrections you require. Please note that
you should only mark page proofs for the purpose of correction or updating. When marking the proofs the
following are useful guidelines:

» Type any substantial new text in a Word document (these are called riders) and email it to the editor
when you send your corrections in. Indicate clearly on the proof where the new material is to be
inserted, e.g. “Rider A for p.102”;

Check that all page/paragraph cross references have been filled in, including in footnotes;

Check that running heads read correctly;

Check that the hierarchy of all headings is correct;

Ensure that all listed or proof queries have been resolved; and

Check that tabular material is set correctly.

VVVYVYY

If you have any queries about the proofs or the marking up process your editor will be happy to help.

Basic formatting and layout, e.g. page numbering, running heads and headings, will be checked in-house by
the editor. It is not essential that you use your valuable time amending this, unless you feel particularly
strongly about a certain aspect. It is more important, at this stage, that you check the accuracy of the
information, e.g. that any legislation is up-to-date and citations are complete. We do ask that you return proofs
by the due date. When we send out the proofs we pre-book time at the typesetters—any delay could mean
missing this slot and may lead to substantial delay in getting the manuscript bound and printed.

2.5 TABLING AND INDEXING

Tables and index are compiled out of house by our legally trained freelances.

2.6 SECOND PROOFS

Where this stage is thought to be appropriate, no extra material can be added and only necessary corrections or
updates can be made. Generally, authors will not see the second proofs, unless previously agreed, and they are
used by editors to ensure additions to the first proof have been made correctly by the typesetter.

2.7 PRESS PROOFS

After we have the marked proofs in-house they are then typeset again with the corrections and additions and
your editor will then receive the press proofs. These are the finished proofs which are checked in house to
ensure all corrections have been included and all pages are present. No new corrections can be made at this
stage.

2.8 PRINTING

Once we are happy with the press proofs, the typeset pages are sent to the printers. Printing time depends on
the size of the publication, the form of binding and whether we have managed to keep to schedule.
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2.9 BOUND COPIES

At this stage we have a finished book. We receive a set of advances from our printers and the number of free
copies agreed in your contract will be sent on to you. Please remember that under your contract you can
receive extra copies at a special discount as long as they are not for resale. At the same time more copies will

be sent to our warehouse where any pre-publication orders will be completed and the book will be available
for general sale.

If you have any questions regarding this process, please contact your commissioning editor:

Janet Campbell janet.campbell@thomsonreuters.com
Kirsty Price Kirsty.price@thomsonreuters.com
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HOW TO GUIDE

H.1 TRACK CHANGES

e Open the document you want to revise.
e Toturn on Track Changes select the “Review” tab (as seen in (a) below) at the top of the screen and click
on the “Track Changes” button (b).

® |
O™ B EST e W= e S 1 Trak Changes, Wincows XP.dac [Zompal B o " -=Xx
@ \J % Changes, Win *Pdoc] tibility Mode] Micoze't Word o

| Hume | wioet  Pagelopet  Retmeies  Mailogs | Revew | Vien  Doeln Adels O Sleled Al

S 1 ot T S . Fird -
I :“ G e o - a Kl P E ] samscer AaBbC| AsBLCel | AaBbCel AaBbeer AaBbC i :mme [
i Emphadis  Haadirg1 | 7 Hommal Strang Subtitle Title o %ﬂ;ﬂs 1 Stlect~ !

= | fdiling |

1. Open e doCumant you Want 1o ravise

2 To tum on Track Changes select the ‘Review' tab at the top of the screen and click on
the Irack Changes butlon

3 Make the charges you want by nseting or deleting text. All insertions and deletions are
visble as par]ﬁe example below

For axample, a changzd paragraph shoud then look like this™

* 1124 Inxedustion

The Building Control eyetem in Scotland ie powsumanil. govemsd by tha Building

(Scotland) Act 20031958 which contains the framework for the Bulding Standards

(Scotland] Reguletiors 0041990 iss amsadsdl The Technical Standards of these

Regulations, which ccnain the detaied nles and procedures, came into operatios on 1
i s the Bl

(" *Cependirg on NoW yOur COMPEIE &5 S6f up, e amendments may not appesr In differing colours. TEA5
ol A Soncam—simely a1sure that all insertions are undedined. and all delations are cossed frough.

“Pleazs DO NOT “accept track changes™ at any tima. Al changes must be visihle whan
submitted.”

If you have any quedes or equire any futher instruction about this process slesse do not
hasitate 10 contact me by email

‘Pagelofl | Word 30 | (P Englih (LX) |
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x

ma = B B TS TN e R Artnar Gire Trark rn--q\l/rs'mmumn-r Winete] . irsasaft Woard -=
&

Hene Insert Page Lareut Refrrences Mailings | Mevitw l e Developer Add-dny et Tharted Acobat

€

| 482l Ly s |t ot | B, (e S rememrssne i 3 e (][
Mew  Dtiete Previotr  Ned Trak | Balloon:
i werd Caunt Conmment - |lcnanges - =

13 Shiow Madkup =
Speling & Reseaich Thesaurut Translate Brcest Rejed @) et Compare Show Seurce Protect
Gramma = = - Donsments© | Documen. =
Crmpire. Pratect

) neviewing Pane -
Tracking

1. Open the dacument you want 13 rag

2 To tum on Track Charges aelaci d-e Raviaw’ (a}. l‘eb a1 the top of the screen and click
on the Track Changes’ buton b)

(a)

3 Make the cnanges yuu want Dr NIRBﬂl!g or ﬂllﬂllg text. All nsetions ard daletions are
H . uldiate is parthi axampli belic_
‘Pagelol?  Worde233 B Enalsh UKl |

o Make the changes you want by inserting or deleting text. All insertions and deletions are visible as per the
example below:

Example
A changed paragraph should then look like this**:

Introduction

1.01 The Building Control system in Scotland is noweurrenthy governed by the
Building (Scotland) Act 20031959 which contains the framework for the
Building Standards (Scotland) Regulations 20041990(as-amended). The
Technical Standards of these Regulations, which contain the detailed rules
and procedures, came into operation on April 1, 20053994, They provide
guidance on achieving the standards set in the Building (Scotland)
Regulations 2004 and are available in two volumes, for Domestic
buildings and for Non-domestic buildings. Both volumes can be
downloaded for free from the Scottish Building Standards Agency
(*SBSA”) Fhey—replaced-the-Building-Standards—(Seotland)-Regulations
108l ondolloubsoanontomepdmonic

(**Depending on how your computer is set up, the amendments may not appear in the differing colours seen
above. This is not a concern—simply ensure that all insertions are underlined, and all deletions are crossed
through.)
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H.2 INSERT FOOTNOTES

o Place the cursor next to the word where you want to insert a footnote.

e To use the automated footnote tool select the “References” tab (as seen in (a) below ) at the top of the
screen and click on the “Insert Footnote” button (b).

@

428 15) ® \/ Complewe Authcr Guide (draftl.doc [Compatiility Mede] - Microsoft Woid hEEin
- Home  fnert  Jagelmeut | Awarences | Mullings  Revww  View  Devaioper  Addin  GetStarad  Acebat 7]
[3p2oa e~ AB‘ L[ insert Enanote | E dmmne sources I E ] Insert Tapie ot me ] tnser ingex. | H" 43 Imsen Tanie of AuEnontie:
T it vpaste Tavie | AR, Nedt Footrote ~ || La Style: aa _ItUpdate Tabe 3 Ugdate Index | ! Lpdate Table
Confents = Footnate i Show Hotes Citation = ﬂlmmw c.lplun ) Cross-reference Entry Umim
= o 5 Cuutions aibbogapty | N )i B Tablz of Authoriies
b [ O N O N Oy A n-s-n-s-n-m-n-u-|-12-|-|3-|-14-|-|5- - AT AR AT

Domestic buildings and for Non-domestic suildings. Bath

canbe di loaded far free from
the scoitis Bullding Standards Agency (SESAL Frey-epiced the BusdingStardardsiSeotiandt

fesslatans 158 t-andalsu

=™ Depending onhow your corrputer is set up, the amendments may notappearin thediffering
coloursseen above. Thisis not a concern—simply ensure that all insertiors are underfined, and all
deletions are crossedthrough.)

INSERT FOOTNOTES

»  Place the cursor next to the word where vouwant to insert a footnote.

* Tousethe automated footnote tool sziec the "References’ tab (as seen in (a) below | at the
top ofthescrzen and click on the ‘Insert Footnote” sutton(b),

€T

Page 200120 | Wordsia 27 | 5 nglsh () |
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@\_ﬂ izl ® vl Camplete Authar Guide ‘draft].doc [Comaatibility Madel - Micrasoft Word masi
- Home  Incwt  Pagalaout | Reterences | Mulings  Beview  View  Devalopar  Adddn  GetStartsd  Acrobat wl
= [2¢ 200 Jext - <[ Insn Encnote ﬁ 3 Manzge sources | :] 7 Insert ianie of Figurzs ] insert ingex I a' 22 IngerE ianie o Aunorties |
5 ! Update Table ' | | AR Nedt Footnote ~ = s oyt A - _if Update Tabiz It Upgate Incex | _if Updace Tatle
Tahis of T i Ircert = | Trveert Mark Mark
Cantents - | |Footnote i Show Notes Citatior, = g Bibllograshy = | Caption LA) Cros-reference Entry |: Citatian
Table of Contents | Foolnotes Citations & Biblognphy | Captions 1§ Indec |
e e
Insert Footnote [Alt-Ctri+F) R AR A TR AR SRS s RS S - B LR IS SRR

Add a footnote to the docement,

Fastnetes are autematically
renumbered as you move text
sround the dotument.

& Press F1 formoie help.

e RS

e This will automatically create a number at the foot of the page—simply insert the text next to this number.
All footnotes will be numbered consecutively using this tool.
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